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Overview

Structure optimization, visualization of molecular 
orbitals and charge densities

Examples: benzene, pyridine

Open shell systems, Jan-Teller distortions

Example: cobaltocene 
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Preparing for the hands-on session 2 …

Log into intact cluster (have a look at a separate sheet 
of paper with instructions)

Switch to a working directory: 

cd ~/ABC_of_DFT/hands-on-sessions/

Copy a script  session2 from dft20 account:
cp ~/../dft20/ABC_of_DFT/session2 .

Type from a command line: 

./session2

Examples (with this tutorial) will be imported to a 
directory 
~/ABC_of_DFT/hands-on-sessions/session2 
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Example 1 – Benzene: structure visualization

Go to a directory with example 1 (benzene): 
cd ~/ABC_of_DFT/hands-on-

sessions/session.2/example.1.benzene

Create you own directory where you are going to run a calculation:
cp -r structure.benzene my.benzene

cd my.benzene

Your directory contains a file coord with atomic positions:
cat coord
$coord

2.27353301545502     -1.31262489848446      0.00000000000000      c

2.27353301545502      1.31262489848446      0.00000000000000      c

0.00000000000000      2.62524979696891      0.00000000000000      c

-2.27353301545502      1.31262489848446      0.00000000000000    c 

-2.27353301545502     -1.31262489848446      0.00000000000000      c

0.00000000000000     -2.62524979696891      0.00000000000000      c

4.03777188872899     -2.33120868688398      0.00000000000000      h

4.03777188872899      2.33120868688398      0.00000000000000      h

0.00000000000000      4.66241737376797      0.00000000000000      h

-4.03777188872899      2.33120868688398      0.00000000000000    h

-4.03777188872899     -2.33120868688398      0.00000000000000      h

0.00000000000000     -4.66241737376797      0.00000000000000      h

$end
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Example 1 – Benzene: structure visualization

Convert file coord to the .xyz format:

t2x coord > coord.xyz

Start a visualization program gOpenMol:

rungOpenMol & 

Load in coordinates by using a menu

of gOpenMol:

File -> Import -> Coords...

You will get a sub-menu where you

can select coordinates from. Load the

coord.xyz file from your directory and 

click on the <Apply> buttom.
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Example 1 – Benzene: structure visualization

You can tune the way your structure is viewed by selecting

View -> Atom type...

and by choosing in the upcoming window Licorice with parameters

Cyl.rad = 0.1; Sph.rad = 0.3 followed by the <Apply> button.
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Example 1 – Benzene: creating an input (step 1)

Call an interactive module define from the directory my.benzene:

define
...

DATA WILL BE WRITTEN TO THE NEW FILE control

IF YOU WANT TO READ DEFAULT-DATA FROM ANOTHER control-TYPE FILE,

THEN ENTER ITS LOCATION/NAME OR OTHERWISE HIT >return<.

Hit <Enter> for the name of input file

xINPUT TITLE OR

ENTER & TO REPEAT DEFINITION OF DEFAULT INPUT FILE

Type e.g. benzene for the title, followed by <Enter>

You will get the „molecular geometry“ menu

SPECIFICATION OF MOLECULAR GEOMETRY ( #ATOMS=0     SYMMETRY=c1  )

YOU MAY USE ONE OF THE FOLLOWING COMMAND

sy <group> <eps> : DEFINE MOLECULAR SYMMETRY (default for eps=3d-1)

desy <eps>       : DETERMINE MOLECULAR SYMMETRY AND ADJUST

COORDINATES (default for eps=1d-6)

susy             : ADJUST COORDINATES FOR SUBGROUPS

ai               : ADD ATOMIC COORDINATES INTERACTIVELY

a <file>         : ADD ATOMIC COORDINATES FROM FILE <file>

....

Type a coord <Enter> to append your structure
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Example 1 – Benzene: creating an input (step 2)

You will see that 12 atoms have been added:

CARTESIAN COORDINATES FOR  12 ATOMS HAVE SUCCESSFULLY

BEEN ADDED.

....

SPECIFICATION OF MOLECULAR GEOMETRY ( #ATOMS=12    SYMMETRY=c1  )

YOU MAY USE ONE OF THE FOLLOWING COMMAND

sy <group> <eps> : DEFINE MOLECULAR SYMMETRY (default for eps=3d-1)

desy <eps>       : DETERMINE MOLECULAR SYMMETRY AND ADJUST

COORDINATES (default for eps=1d-6)

susy             : ADJUST COORDINATES FOR SUBGROUPS

....

Switch on the symmetry detection by entering 

desy <Enter>

... symmetry detection will print out Schönflies symbol, group 

generators and the main menu with correct symmetry D6h

SPECIFICATION OF MOLECULAR GEOMETRY ( #ATOMS=12    SYMMETRY=d6h )

YOU MAY USE ONE OF THE FOLLOWING COMMANDS :

...
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Example 1 – Benzene: creating an input (step 3)

Next step is to provide internal coordinates (bonds, angles, etc...)

required for a geometry optimization; type

ired <Enter>
JUST FOUND ISOLATED RING OF SIZE  6 :

1    2    3    4    5    6

GEOSPY: NBDIM:       2  NDEGR:       2

Lowest Eigenvalue of BmBt is:          0.3819660113

GEOSPY: ATTENTION!

natural internals not linearly independent?

Decoupling with "globtry"=    0.9999999999000000

Lowest Eigenvalue of projected BBt           0.3819660113 No:     2

Quotient of Eigenvalues           1.0000000000

OCCUPATION OF BLOCKS:    2    0    0    0    0

SPECIFICATION OF MOLECULAR GEOMETRY ( #ATOMS=12    SYMMETRY=d6h )

YOU MAY USE ONE OF THE FOLLOWING COMMANDS :

....

We are done with the molecular geometry menu; to proceed, type

* <Enter>
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Example 1 – Benzene: creating an input (step 4)

Next is the „atomic attributes“ menu:   

ATOMIC ATTRIBUTE DEFINITION MENU  ( #atoms=12    #bas=12    #ecp=0     )

b    : ASSIGN ATOMIC BASIS SETS

bb   : b RESTRICTED TO BASIS SET LIBRARY

bl   : LIST ATOMIC BASIS SETS ASSIGNED

....

You may check that a default basis set def-SV(P) is assigned:

bl <Enter>
------------------------------------------------------------------------

INDEX | BASIS SET NICKNAME

------------------------------------------------------------------------

1  | c def-SV(P)

2  | h def-SV(P)

------------------------------------------------------------------------

You may switch to other basis (e.g. def-TZVP, of triple-ζ quality):

b all def-TZVP <Enter>

To proceed for the next menu, type

* <Enter>
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Example 1 – Benzene: creating an input (step 5)

The next menu is the one where define determines initial molecular

orbitals with, e.g., an extended Hückel guess.

OCCUPATION NUMBER & MOLECULAR ORBITAL DEFINITION MENU

CHOOSE COMMAND

infsao     : OUTPUT SAO INFORMATION

eht        : PROVIDE MOS && OCCUPATION NUMBERS FROM EXTENDED HUECKEL GUESS

use <file> : SUPPLY MO INFORMATION USING DATA FROM <file>

man        : MANUAL SPECIFICATION OF OCCUPATION NUMBERS

hcore      : HAMILTON CORE GUESS FOR MOS

&          : MOVE BACK TO THE ATOMIC ATTRIBUTES MENU

THE COMMANDS  use  OR  eht  OR  *  OR q(uit) TERMINATE THIS MENU !!!

FOR EXPLANATIONS APPEND A QUESTION MARK (?) TO ANY COMMAND

To choose the Hückel guess, type 

eht <Enter>

You will be asked a lot questions: accept all defaults
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Example 1 – Benzene: creating an input (step 6)

There are two important questions during that procedure:

ENTER THE MOLECULAR CHARGE  (DEFAULT=0)

If you have a charged system, you have to tell that define at this 
point. For now, we accept a neutral molecule by hitting <Enter>

The second question is about occupation numbers

AUTOMATIC OCCUPATION NUMBER ASSIGNMENT ESTABLISHED !

FOUND CLOSED SHELL SYSTEM !

HOMO/LUMO-SEPARATION :  0.167139

ORBITAL  SYMMETRY      ENERGY     DEFAULT

(SHELL)    TYPE                 OCCUPATION

11     3e1u        -0.51863      4

12     1b1u        -0.50821      2

13     1e1g        -0.48203      4

14     3e2g        -0.43095      4

15     1e2u        -0.26381      0

16     1b1g        -0.08611      0

17     4e1u         0.39013      0

DO YOU ACCEPT THIS OCCUPATION ?  DEFAULT=y

For our case, the restricted single occupation is OK, press <Enter>
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Example 1 – Benzene: creating an input (step 7)

We will get the last “general menu”:

GENERAL MENU : SELECT YOUR TOPIC

scf    : SELECT NON-DEFAULT SCF PARAMETER

mp2/cc2: OPTIONS AND DATA GROUPS FOR MP2, CC2, ETC.

ex     : EXCITED STATE AND RESPONSE OPTIONS

prop   : SELECT TOOLS FOR SCF-ORBITAL ANALYSIS

drv    : SELECT NON-DEFAULT INPUT PARAMETER FOR EVALUATION

OF ANALYTICAL ENERGY DERIVATIVES 

(GRADIENTS, FORCE CONSTANTS)

rex    : SELECT OPTIONS FOR GEOMETRY UPDATES USING RELAX

stp    : SELECT NON-DEFAULT STRUCTURE OPTIMIZATION PARAMETER

e      : DEFINE EXTERNAL ELECTROSTATIC FIELD

dft    : DFT Parameters

...

Choose DFT, by entering dft <Enter> , and then on <Enter>

STATUS OF DFT_OPTIONS:

DFT is used

functional b-p

....

Just <ENTER>, q or '*' terminate this menu.

Type q <Enter> to quit and go back to the general menu
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Example 1 – Benzene: creating an input (step 8)

General menu allows further options to control over the calculation

GENERAL MENU : SELECT YOUR TOPIC

....

ri     : RI Parameters

rijk   : RI-JK-HF Parameters

trunc  : USE TRUNCATED AUXBASIS DURING ITERATIONS

marij  : MULTIPOLE ACCELERATED RI-J

dis    : DISPLAY MOLECULAR GEOMETRY

list   : LIST OF CONTROL FILE

&      : GO BACK TO OCCUPATION/ORBITAL ASSIGNMENT MENU

* or q : END OF DEFINE SESSION

Calculations for larger molecules can be substantially accelerated if

one employs a so-called resolution of the identity (RI) approximation 

for the evaluation of Coulomb energy integral, where the charge

density is expanded over the auxiliary basis set.
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Example 1 – Benzene: creating an input (step 9)

To activate RI approximation, type ri <Enter>, followed by
on <Enter> in the upcoming sub-menu. 

After done so, you will find
STATUS OF RI-OPTIONS:

RI IS USED

Memory for RI:           200 Mb

Filename for auxbasis: auxbasis

....

Use <ENTER>, q, end, or '*' to leave this menu

Type q <Enter> to go back to the general menu, followed 
by q <Enter> to finish define session.
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Example 1 – Benzene: creating an input (remarks)

After define session is finished, you’ll find following files in your 
directory:  control, basis, auxbasis, mos.

File control contains all settings to control over your calculation.  

Files  basis & auxbasis contain information about basis functions 

(contracted Gaussian type orbitals) and auxiliary basis set to be used 
for wave functions (molecular orbitals = MOs) and charge density 
expansions, respectively.

File mos contains MO energies and expansion coefficients of MOs 

over the basis functions.  

Files control and mos will be updated during the calculation.
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Example 1 – Benzene: running calculation

To run a DFT calculation, call from the current directory

ridft > ridft.out &

After a minute, scroll up the output file: you’ll find the energy diminishes 
within the self-consistent cycle, and is converged after 9 iterations:

ITERATION  ENERGY          1e-ENERGY        2e-ENERGY     NORM[dD(SAO)]  TOL

.....

4  -232.06592645088    -715.02052527     278.59415462    0.000D+00 0.327D-09

.....

5  -232.07193048496    -715.42066923     278.98829454    0.000D+00 0.327D-09

.....

6  -232.07269666729    -715.66752979     279.23438892    0.000D+00 0.327D-09

.....

7  -232.07272816194    -715.63626449     279.20309213    0.000D+00 0.327D-09

.....

8  -232.07273547481    -715.68122603     279.24804636    0.000D+00 0.327D-09

ENERGY CONVERGED !

.....

9  -232.07253692230    -715.67741588     279.24443476    0.000D+00 0.327D-09

.....

convergence criteria satisfied after    9 iterations

Reason for a slightly different value: 
a denser grid for a numerical integration is used !
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Example 1 – Benzene: checking convergence

To check convergence of the 
energy, you can use script 
cgnce, which exports output 
info to gnuplot. Type

cngce ridft.out

The window on the right will 
show up (press <Enter> to 

quit)

The converged ground state 
energy (in Hartree units) is 
appended to file energy   

(first column):

$energy      SCF               SCFKIN            SCFPOT

1 -232.0725369223      229.7317088723     -461.8042457946

$end
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Example 1 – Benzene: data post-processing

Data post-processing script eiger provides information about orbital 
energies and occupations. Type eiger > molecular.levels.dat
and afterwards  cat molecular.levels.dat
benzene : bp-86, def-SV(P)

Total energy =   -232.0725369223 H =     -6315.0186312 eV

HOMO-LUMO Separation

HOMO:    14.     1 e1g   -0.23145578 H =     -6.29824 eV

LUMO:    15.     1 e2u   -0.03736717 H =     -1.01681 eV

Gap :                    +0.19408861 H =     +5.28142 eV

Number of MOs=     64, Electrons=     42.00, Symmetry: d6h

Nr.   Orbital    Occupation       Energy

....

16.     4 a1g                   +0.043231 H =        +1.176 eV

15.     1 e2u                   -0.037367 H =        -1.017 eV

14.     1 e1g      4.000        -0.231456 H =        -6.298 eV

13.     3 e2g      4.000        -0.304977 H =        -8.299 eV

12.     1 a2u      2.000        -0.333260 H =        -9.068 eV

11.     3 e1u      4.000        -0.378680 H =       -10.304 eV

10.     1 b1u      2.000        -0.401898 H =       -10.936 eV

....

2x degenerate 

HOMO

2x degenerate 

LUMO
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Example 1 – Benzene: structure optimization

To perform geometry optimization of benzene, make a new directory:
cd ~/ABC_of_DFT/hands-on-

sessions/session.2/example.1.benzene

cp -r my.benzene my.benzene.relaxed

cd my.benzene.relaxed

Call from the current directory jobex script:
jobex -ri -grad -c 25

-ri tells the script to use modules with RI

implementation;

-grad tells to perform a gradient evaluation as 

the first step;

-c <number> accounts for a maximum amount of

relaxation steps

Further information can be obtained via jobex -h
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Example 1 – Benzene: structure optimization

At each step of optimization procedure, information on the energy is  
appended to the file energy; type: cat energy
$energy      SCF               SCFKIN            SCFPOT

1 -232.0725369223      229.7317088723     -461.8042457946

2 -232.0764088838      229.3325106808     -461.4089195645

3 -232.0765621000      229.3004492613     -461.3770113613

4 -232.0765632300      229.2972414010     -461.3738046309

5 -232.0765631460      229.2967217448     -461.3732848908

6 -232.0765631243      229.2965858552     -461.3731489795

$end

Information on gradient and new coordinates is appended to the file 
gradient; type: grep cycle gradient
cycle =      1    SCF energy =   -232.0725369223   |dE/dxyz| =  0.042942

cycle =      2    SCF energy =   -232.0764088838   |dE/dxyz| =  0.016091

cycle =      3    SCF energy =   -232.0765621000   |dE/dxyz| =  0.001375

cycle =      4    SCF energy =   -232.0765632300   |dE/dxyz| =  0.000194

cycle =      5    SCF energy =   -232.0765631460   |dE/dxyz| =  0.000021

Question: what are the C-C and C-H bond lengths that you’ve got? 

How well do these values compare with experimental data?
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Example 1 – Benzene: visualization of orbitals

Go to your directory with the calculation for benzene, e.g.

cd ~/ABC_of_DFT/hands-on-

sessions/session.2/example.1.benzene/my.benzene.relaxed

Call eiger script to get info about orbital energies

You’ll see HOMO is orbital #14, LUMO is #15, etc …

To plot frontier orbitals, add to control file a line (before $end)

$pointval mo 13-16

and call: ridft -proper

You’ll see four *.plt files on output. Each file name is associated 

with one orbital

To plot a charge density, a line $pointval dens is required in 
control file
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Example 1 – Benzene: visualization of orbitals

*.plt files can be visualized 

with gOpenMol. 

Call it from a command line: 

rungOpenMol coord.xyz &

Go to the menu: 

Plot -> Contour...

You will get the window

where you can load in the

*.plt files:  first click on 

Browse, load the file, then 

press  Import
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Example 1 – Benzene: visualization of orbitals

The Contour Control Window will expand, writing out the minimum

and maximum value of the wave function amplitude (or density)

that has been read in.

For each of the 10 fields, called Value 1 till Value 10, you can now

enter a value that will define the iso-surface of the wave function’s

amplitude (or density iso-surface, if charge density is plotted). 

With Colour... and Details... you can change the color and

the opacity of each contour.

Do not forget to click on the Apply button.
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Example 1 – Benzene: visualization of orbitals

Example shows one of the antibonding (π*-like) LUMOs of benzene
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Example 1 – Benzene: visualization of orbitals

Exercise: plot two degenerate HOMOs of benzene. 
Convince yourself that these two orbitals form an aromatic 

π-electron system, delocalized over the entire ring.

Userful remark: your pictures can be exported to graphics 

files. For that, use the menu of gOpenMol 

File -> Hardcopy ... 

where an upcoming window allows to choose among 

graphics formats.
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Example 2 – Pyridine (exercise)

Consider a pyridine molecule, C5H5N, which is structurally related to 
benzene, with one CH group replaced by N atom.  Look at 

~/ABC_of_DFT/hands-on-

sessions/session.2/example.2.pyridine/structure.pyridine

Visualize atomic structure 

of the molecule.

Compute electronic structure of 

pyridine, assuming a default C2v

symmetry.

Perform atomic structure relaxation.
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Example 2 – Pyridine (exercise)

Visualize frontier molecular orbitals of pyridine (few 

occupied and few unoccupied ones).

Questions:

1. N atom has a single “lone pair” pointing outwards 

the ring. One of the σ-type molecular orbitals 

resembles this lone pair. Which orbital is that? 

2. Due to a structural similarity, the some frontier

molecular orbitals of pyridine resemble double

degenerate HOMO (π) and LUMO (π*) of benzene. 

Can you show, which are these orbitals? 

Why degeneracy is lifted in case of pyridine?
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Example 3 – Cobaltocene (open shell: step 1)

Structure of Co(C5H5)2 can be found at
~/ABC_of_DFT/hands-on-sessions/session.2/example.3.open-

shell.cobaltocene.d5d/structure.cobaltocene

When creating an input with define, 

impose a high D5d symmetry (desy 0.3) 

Due to orbital energies degeneracy, 

automatic occupation of Hückel’s

orbitals will fail. 

Help define by choosing an open shell 

occupation for a charge neutral complex

with 7 unpaired spins as a starting 

guess (please, look at the next slide … )�
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Example 3 – Cobaltocene (open shell: step 2)

After you’ve specified a zero charge on the complex, you’ll get …

NUMBER OF ELECTRONS IN YOUR MOLECULE IS   97

YOU HAVE TO ASSIGN OCCUPATION NUMBERS MANUALLY

>> UHF << : ALPHA AND BETA SHELLS  (a,b)

>> RHF << : CLOSED AND OPEN SHELLS (c,o)

OCCUPATION NUMBER ASSIGNMENT MENU  ( #e=97  #c=0  #o=0)

s         : CHOOSE UHF SINGLET OCCUPATION

t         : CHOOSE UHF TRIPLET OCCUPATION

u <int>   : CHOOSE UHF WITH <int> UNPAIRED ELECTRONS

...

ENTER COMMAND

Type u 7 <Enter>

(1, 3, or 5 unpaired spins will not be accepted)

Proceed further with define, setting up DFT, RI, MARI-J options
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Example 3 – Cobaltocene (open shell: step 3)

After define session is finished, you’ll find  two files, alpha and 

beta, accounting for MOs with αααα (“up”) and ββββ (“down”) spins

Open shell systems (and, also, large systems) require electronic

temperature smearing of occupation numbers within first steps of self-

consistent cycle to encourage convergence. 

That is done with help of mkfermi script, which modifies your 
control file by adding (among others) the following line:

$fermi tmstrt=300 tmend=10 tmfac=0.8 hlcrt=0.5 stop=1.0E-3

The initial temperature 300 K is reduced at each cycle by the factor

0.8 until it reaches the value 10 K

To run calculation, type 

mkfermi 

ridft | tee cobaltocene.out
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Example 3 – Cobaltocene (open shell: step 4)

After single-point energy calculation is finished, scroll up the output 

file. You’ll find the DFT ground state with one unpaired spin:

ITERATION  ENERGY          1e-ENERGY        2e-ENERGY     NORM[dD(SAO)]  TOL

60  -1769.6462134688    -4216.3089987     1552.3456264    0.000D+00 0.170D-09

Exc = -117.556943916     Coul =  1669.90257029  

Ntotal = 96.999988223      Nspin = 1.0000005307

Na = 48.999994377         Nb = 47.999993846

current damping = 9.900

...

End of SCF iterations

convergence criteria satisfied after   60 iterations

Proceed further with geometry optimization: set electronic 

temperature to 10 K by modifying (red) one line in control file to

$fermi tmstrt=10 tmend=10 tmfac=1.0 hlcrt=0.5 stop=1.0E-3

Perform structure relaxation: 
nohup jobex -ri –grad –c 50 > jobex.out &

Number of unpaired spins
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Example 3 – Cobaltocene (open shell: step 5)

Get information about orbital energies (eiger script)�
cobaltocene d5d

Total energy =  -1769.6597050510 H =    -48154.9180980 eV

HOMO-LUMO Separation

HOMO:    63. a   5 e2g   -0.09829840 H =     -2.67484 eV

LUMO:    64. b   5 e2g   -0.06691752 H =     -1.82092 eV

Gap :                    +0.03138089 H =     +0.85392 eV

Number of MOs=    226, Electrons=     97.00, Symmetry: d5d

Nr.   Orbital    Occupation       Energy

...

65. a   4 e2u                   +0.021386 H =        +0.582 eV 

64. b   5 e2g                   -0.066918 H =        -1.821 eV

63. a   5 e2g      1.000        -0.098298 H =        -2.675 eV

62. b   4 e1g      2.000        -0.162209 H =        -4.414 eV

61. b   8 a1g      1.000        -0.174730 H =        -4.755 eV

60. a   4 e1g      2.000        -0.179628 H =        -4.888 eV

59. a   8 a1g      1.000        -0.187986 H =        -5.115 eV

HOMO : double degenerate αααα level (E2g symmetry) is occupied by one electron
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Example 4 – Cobaltocene (Jahn-Teller effect)

In nature, orbital energies degeneracy is lifted due to 

Jahn-Teller distortions: a non-linear molecule with a degenerate

electronic ground state will undergo a geometrical distortion, which

removes that degeneracy, because the distortion lowers the overall 

energy of the complex.

HOMO:

2x degenerate

E2g

E1g

Ag

D5d C2h

Bg

Ag

Ag

Ag

Bg

degeneracy 

is lifted

αααα ββββ αααα ββββ

gaining energy
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Example 4 – Cobaltocene (Jahn-Teller effect)

Exercise: illustrate Jahn-Teller effect with your 
calculation 

Take a structure of Co(C5H5)2  at
~/ABC_of_DFT/hands-on-sessions/session.2/example.4.open-

shell.cobaltocene.c2h/structure.cobaltocene

Within define session, choose C2h symmetry. 

For a charge neutral complex, approve an open shell 
occupation with one unpaired spin.

Perform a DFT calculation, and a subsequent structural 
relaxation: do not forget about the Fermi smearing 
(mkfermi script) !
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Example 4 – Cobaltocene (Jahn-Teller effect)

Estimate energy difference for structures with D5d and C2h symmetry.

Answer: GS DFT energy for the C2h structure is lower by ~ 0.11 eV

(value is given for the def-SV(P) basis, “b-p” BP86 functional)�

Compare KS spectrum of complexes with different symmetries. 

You’ll find, the “HOMO doublet” splits to HOMO (occupied) and

LUMO (unoccupied) levels.  What is the splitting? 

Answer: ~ 0.4 eV (def-SV(P) basis, “b-p” BP86 functional)�

Hint: you can compare output of your calculations for the two cases 

with those at

D5d: .../session.2/example.3.open-

shell.cobaltocene.d5d/output.cobaltocene/output.jobex

C2h: .../session.2/example.4.open-

shell.cobaltocene.c2h/output.cobaltocene/output.jobex
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Exercise: Plot charge and spin densities of cobaltocene: show that 
unpaired spin is localized mainly on Co atom. That may look like …

Charge density Spin density

Example 4 – Cobaltocene: charge & spin densities


